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1 Introduction
The present document constitutes Deliverable 6.5 “Guidelines and protocols for the flexible
moulding and for the installation of anchoring systems and joints” in the framework of the EASEE
project.
This deliverable reports the activities carried out within Work Package 6, and specifically within
Task 6.4 “Application Guidelines”. The description of this Task in the DoW is reported below:
“The preparation of protocols and guidelines for each developed application will be a key task in
the work programme. Indeed, the base requirement for all the components to be developed is the
utilisation ease: this specification will increase the industrial exploitation of the product. Protocols
and guidelines will be written in the form of technical reports and checklist, but detailed
troubleshooting tables will be prepared as well. As the control system of the reconfigurable
system will be deeply integrated with the Pattern Generation tool, the large part of required
operations are performed autonomously, and only few checks are expected by the human
operator. Guidelines for the use of the software tool will be prepared, as well as protocols for the
manufacturing of envelope elements by means of the flexible tool. Although anchoring are well
known elements for construction manpower, protocols for their installations will be prepared
showing the installation upon the building’s envelope through the laser projection system.
Particular attention will be paid at the preparation of installation protocols for fenestration
joints, where the correct installation is crucial for final performances. Visual directives such as
pictures and/or video samples will be provided to help the user. These activities will be carried out
by DAPP, in collaboration with all the end-users (construction) SMEs in the consortium.”
Thus, the document mainly focuses on the following main project results:
•
•
•
•

Design Tool, developed in Task 5.3 “Component construction guidelines module”
Adjustable formwork for panels manufacturing, developed within WP6 “Processes and
application guidelines”
Panels anchoring systems, developed in Task 6.3 “Development of anchoring systems and
joints”, together with the panels for the exterior retrofitting finalization
Panels joints, investigated within WP2 and strictly linked also to WP6 activities

To achieve the Task goals, the document has been mainly structured into 2 main sections:
•
•

Section 1 aims at providing technical data sheets of the above mentioned project results
and identifying the main end-users, altogether with their needs, in order to valorize how the
innovative aspects of each result is going to address those needs.
Section 2, which is the core of the document, aims at providing guidelines for each project
result used (with a detailed description of the steps to be performed also with the help of
screen shoots and checklists). Trouble shooting tables are included within this section, thus
could constituting a stand-alone document to be potentially attached and sold together with
each project result, in order to increase their industrial exploitation value.
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2 EASEE project retrofitting process
The EASEE project aims at providing an innovative building retrofitting process based on high level
prefabrication of components, characterized already at the manufacturing stage by the final
appearance, without additional finishing on site. The first step of the retrofitting process consists in
the careful assessment of the envelope from a structural and energetic point of view, as well as in
terms of other non technical parameters that will be useful for the planning of the retrofitting
intervention. The structural and physical conditions of the building is thus evaluated through 3D
laser scanning allowing to acquire a very detailed model and geometrical relief of the building.
The detailed model and the geometrical relief is finally respectively elaborated through the Design
Tool and Retrofitting Planner that have many-fold functions.
From one side, the Retrofitting Planner provides an assessment of the current energetic
performances of the building, taking into account also complementary information on the HVAC
status, roof and basement situation, energetic signature of the building with the purpose of clearly
evaluating and freezing the building baseline to define the best combination of retrofitting solutions
for all or single parts of the envelope. In this respect, the Retrofitting Planner also simulates energy
performance of the building with different retrofitting combinations, providing a ranking of the
available options also taking into account non technical parameters as cost, expected service life,
maintenance, installation and return of investment.
On the other side, if external retrofitting is needed, the Design Tool, through pattern recognition
techniques, provides the design specifications for the off-site production of the prefabricated
components, minimising the number of shapes required, and evidencing the critical points where
specific solutions for the joints have to be adopted.
Thus, the Retrofitting Planner communicates to the design tool the technical specification of the
external retrofitting panels to be manufactured, installed to guarantee the expected building energy
saving. The Design Tool evaluates the correct positioning of such retrofitting solution, taking into
account possible window/piping interfaces. Once the panels number and sizes are optimized and
their position is validated also under the structural point of view, the insulating panels, having the
final appearance of the façade, are produced through a dedicated formwork, able to produce
different panels sizes and textures.
The correct positioning of the modular elements could is ensured for instance by projecting laser
dots onto the façade for the correct placement of the anchoring system. Proper anchoring
systems and specific joints selection complete the building external retrofitting.
Vertical platforms, suspended cradles or cherry pickers are then used to install the panels avoiding
in this a way the installation of fixed scaffoldings.
The following scheme represents the above explained building external retrofitting process.
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Figure 1: Building External Retrofitting Process

D6.5: Guidelines and protocols for the flexible molding and for the installation of anchoring systems and joints

6

2.1 Design Tool

DESIGN TOOL
DESCRIPTION
The Design Tool is an integrated part of the
Retrofitting Process developed during EASEE
Project. Together with EASEE novel insulation
systems,
the
building
owner
(or
administrator/manager) gets a set of tools and
services, which includes assessing building
geometry, thermal simulation, planning of
panels design.
Design Tool is an application dedicated for
construction purposes, allowing to place virtual
panels on the buildings surface in 3D space.
The panels are created using a grid generated
by corners and edges off the building and other panels; therefore it is easy to control their size and
the way they fit. Panels could be then exported into documentation allowing to manufacture them
and to mount them correctly on the real building.

REQUIREMENTS:
Hardware:: there is no particular requirements regarding computer for the software;
software typical office
PC computer is sufficient.
Software:: Windows XP or higher is recommended. Additionally, Design Tool utilizes National
Instruments LABVIEW Runtime Environment, which is provided with the software, free of charge.
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END USERS:
Planning a panel distribution on the façade is not an easy task, various different constrains exist:
•
•
•
•
•

Architectural details – panels distribution needs to be planned with respect to aesthetic and
technical facade features that affect building final appearance
Mechanical strength – panels size and distribution shall take into account building structure
and therefore different limits of load per square meter of wall
Anchoring systems – maximum size of panel and optimum anchors location on the façade
have to be chosen wisely according to building material and construction type
Tolerances – panels distribution shall take into account mounting process (joints, etc) to
avoid inaccuracies or problems during installation
Manufacturing constraints – manufacturing techniques constraints (limited shapes, etc)
shall be taken into account to find the best trade-off between costs and panels number

Due to the complexity of the task (planning panel distribution on the facade), actual enduser of the software should be an architect or structural engineer responsible for the whole
retrofitting process.

BLOCK DIAGRAM
Panels distribution
(each panel location preview) to
easy installation process

Thickness/material data
(Retrofitting Planner)

STL format, both
text and binary

Geometrical building
(3D Laser Scanner)

STL format, both
text and binary

• STL model
• Text file, that contains
information such as panel
name, material, geometry etc
• 3D preview of panel location
on the façade

Design tool
(EASEE Editor)

Panels geometry (to be sent to
the manufacturers) to easy
panels manufacturing process
• STL model
• Text file, that contains
information such as panel
name, material, geometry etc
• Image (PNG file) that contains
technical drawing of a panel
• HTML file allowing for an easy
access to exported files
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2.2 Formwork for panels manufacturing

ADJUSTABLE FORMWORK
DESCRIPTION
The adjustable formwork is a dedicated technological equipment designed for the manufacturing of
the multi-layer panels for the building external envelope retrofitting. Indeed, the formwork is able to
manufacture the sandwich prefabricated panels developed within the project with different sizes
and geometries, aiming at the best trade-off between system’s flexibility (possibility to produce
different geometries) and stress resistance while customizing the process to increase the
automation level.

REQUIREMENTS:
•
•

•
•
•
•

•

The formwork has to be accurately brushed and cleaned between each use, in order to
avoid that mortar remainders and dirt accumulate on junctions.
Counter-moulds to decorate the external side of the building shall be bonded to the main
surface of the formwork, so there is no need for fastening details (such as holes, sockets,
etc.). On the contrary, EPS blocks have to be securely fastened within the formwork at the
correct distance, as the TRM layers thickness depend on this precise position. This can be
done either with slight interference between the sides of the cavity or with fasteners.
The top side shuttering must be removable in order to extract the panel and lift it with the
overhead crane.
Each movable wall of the formwork has to withstand the curing pressure and they have to
also be connected each other; this shall be done through highly resistant connectors that
can be easily unclamped when the panel is extracted.
The formwork has to be equipped with a proper bucket for the mortar pouring.
As both some clamping elements and the venting valves are placed close to the top
shuttering, the upper part of the formwork must be safely reachable with a walkway. This
will be useful also for panel de-moulding operations (eyebolts installation in their holes in
dedicated boxes, spreader beam hooking, etc.).
The panel have to cure for about at least 8-10 h, depending on the environmental
conditions of the plant (mainly temperature and humidity). In order to increase the
productivity, the formwork will be equipped with accelerated curing devices to warm the
cavities and keep them in temperature.
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END USERS:
•

Retrofitting panels manufacturers
Precast companies and construction companies active in the retrofitting market

•

BLOCK DIAGRAM
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2.3 Installation process

INSTALLATION PROCESS
DESCRIPTION
Based on the 3D model of the building and
user’s guideline, the Design Tool provides the
design specifications for the off-site production
of the prefabricated components, minimising
the number of shapes required and evidencing
the critical points where specific solutions for
the joints have to be adopted. According to the
selected retrofitting solution and considering
possible window/piping interfaces, insulating
prefabricated
panels
having
the
final
appearance of the façade are thus produced
using the related manufacturing process. The
correct positioning of the modular elements is
then ensured through a dedicated installation
technique of projecting laser dots onto the
façade for the correct placement of the anchoring systems. Vertical platforms, suspended cradles
or cherry pickers are used to install the panels; the lack of human intensive on-site activities and of
wet processes do not require the installation of fixed scaffolds.

REQUIREMENTS:
Skilled people properly trained on the installation technique.
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END USERS:
Skilled and trained workers of construction companies (mainly SME)
BLOCK DIAGRAM
Building retrofitted
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Panels installation

Equipment for installation
Design Tool: panels distribution
(each panel location preview) to
easy installation process
• STL model
• Text file, that contains
information such as panel
name, material, geometry etc
• 3D preview of panel location
on the façade

Joints

Anchoring systems

Multi-layer retrofitting panels

Applied
displacement

Supporting
bar
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3 Guidelines and troubleshooting tables
This section aims at valorising the products (Design Tool) and the processes (panels'
manufacturing and installation) described in the previous paragraphs by means of their technical
fact-sheets, by providing the dedicated guidelines to be attached and sold together.
Troubleshooting tables are also developed, highlighting the main problems that might occur while
following the provided guidelines (while using the Design Tool or while manufacturing the panels
as well as installing them).
The guidelines aim to streamline processes, namely to guide the Design Tool users and to train the
prefabricated insulating panels manufacturers and installers, according to a set routine or sound
practice. By definition, following a guideline is never mandatory. Guidelines are not binding and
thus are not mandatory enforced. These guidelines have been written down based on the
experience acquired from the project activities performed. Guidelines are provided in a synthetic
but exhaustive way (step by step), and each step is correlated with one or more pictures that
should be as much as possible self explaining. Thus the following guidelines are provided:
•
•
•

Guideline for using Design Tool
Guideline for prefabricated insulating panels manufacturing
Guidelines for prefabricated insulating panels installation

Also videos will be/have been provided, in particular:
•
•
•

Demo on the use of the Design Tool, as a “Help” function and as a side tool for the user.
(soon on the website).
Video of the prefabricated panels manufacturing to be used by the future panels
manufacturers interested in purchasing the panels formwork (soon on the website).
Video of the prefabricated panels installation to be used during training courses for
installers and workers of SMEs interested in acquiring this new skill and expertise (on the
website).

D6.5: Guidelines and protocols for the flexible molding and for the installation of anchoring systems and joints

13

3.1 Design Tool
First step to use the Design Tool is the installation of the software tool. To do this, the following
steps shall be performed:
•
•

Copy all provided files to your hard drive.
Install LabView runtime environment, by double clicking executable file
(LVRTE2009_SP1f4std.exe) provided with the installation files. Follow installation
instructions provided within the wizard (Figure 2)

Figure 2: Installing runtime environment

•

Run Design Tool by double clicking “EASEE Editor.exe” file, in the EASEE Editor folder
provided with the installation files (Figure 3)

Figure 3:Running Design Tool
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•

(OPTIONAL) You can access help files by double clicking help.html file that can be found in
the main provided folder (Figure 4)

Figure 4: Running help

Once the software has been installed, the user can start using it by creating a new project. To
create a new project the user shall enter the main application window (Figure 5). The main
application window is divided into three parts:
•
•
•

Panel tree, in which the user can organize the created panels into a multilayer and
hierarchic structure;
3D view of the panels and building models;
Panel creation controller.

Figure 5: Main application window

After importing the model, the user can navigate 3D space using keyboard and mouse using the
following combinations:
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•
•
•

Sliding the mouse with the left mouse button pressed – turning the camera around the
building
Ctrl + sliding the mouse with the left mouse button pressed – sliding the camera to the
sides
Shift + Sliding the mouse with the left mouse button pressed – zooming in/ zooming out.

After clicking the right mouse button on the 3D view an Autofocus option is enabled, switching to
default camera view. An experimental zoom in/out option is also available (switched off by default)
using mouse wheel. To activate it change the value of the key Mouse Wheel Zoom Factor in the
Settings.ini file to a non-zero value e.g. 100. After restarting the application you are able to zoom in
and out using mouse wheel.
The user is thus able to open and navigate the main
window by selecting from the menu “Tools ->
Navigation Window”. The navigation window
simplifies the creation of panels by drawing a
preview of the panel that is being created and
allows to make measurements of length (in meters),
angles and surface. Additionally the information of
the existing control points layout is displayed,
placement of the cursor (XYZ in millimetres) and the
object on which the cursor is currently placed.

Figure 6: The navigation window

Note: Panel contour visible in the Navigation
Window may in fact be its mirror image reflected
vertically

D6.5: Guidelines and protocols for the flexible molding and for the installation of anchoring systems and joints

16

The scheme below represents the main steps to be performed in order to use the tool for the
panels design and positioning.
Creating a new projects

1) Building model import

2) Creating panels
Creating
rectangular
panels

Creating
polygonal
panels

Duplicate
existing
panels

3) Organizing and editing panels

4) Export
Panels size
export

Building model export

Building grid export

Figure 7: Guidelines blocks flow scheme for Design Tool use
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3.1.1 Glossary
The description of user settings contained in the “Settings.ini” file located in the main application
folder is provided in the following items.
To change these settings, it is necessary to close the application, edit the file and then run the
application again. The values given in brackets are default values.
To reset all settings to default values it is necessary to delete the “Settings.ini” file and the
application will create a new file while starting with default settings values.
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Grid Plane Threshold: Parameter of the grid generation algorithm. If the dihedral angle
between two triangle is less than this value (in degrees), then their joint side becomes the
grid edge (179)).
Grid Edge Threshold: Parameter of the grid generation algorithm. If the angle between two
model edges is greater than this value (in degrees) the edges are then connected into one
(179).
Control Point Size: The size of a control point in millimeters (100). .
Grid Edge Snap Distance: The distance of snap to the grid edge in millimeters (50).
Grid Node Snap Distance: The distance of snap to the grid nodes in millimeters (50).
Grid Edge Radius: The radius of the cylinder that creates the edge of the grid (in
millimeters). This value should be less that Grid Edge Snap Distance and Grid Node Snap
Distance. In other case the attraction to the grid will not be possible (5).
Grid Node Radius: The radius of the sphere that creates the grid node (in millimeters)(10).
This value should be less that the value of Grid Edge Snap Distance and Grid Node Snap
Distance. Otherwise the attraction to the grid will not be possible.
Cursor Size: The size of the cursor in millimeters (100).
Plane Tolerance: Maximum allowed distance between the point and the plane, so that the
point is considered as laying on the plane in millimeters. This parameter is used on the
Navigation Window (1).
Exported Image Width: The width of the exported PNG image in pixels (800).
Exported Font Name: The name of the font used during exporting for the description of the
length of sides and panel angle values (Courier New).
Exported Font Size: The size of the font used during exporting for the description of the
length of sides and panel angle (14).
Overview Positions: The number of miniatures attached to exported PNG images showing
the location of the panels (8).
Overview Image Size: The Size (length and width) of the miniatures with panel location in
pixels (200).
Overview Distance: The distance between the building and the camera while creating
miniatures with panel location in meters (50).
Overview Height: The height camera is set on while creating miniatures with panel location
in meters (2).
Overview FOV: The camera angle while creating miniatures with panel location in degrees
(30).
Mouse Wheel Zoom Factor: The parameter controlling the camera zoom in/out degree
while using the mouse wheel. This function is experimental, that is why it is turned off by
default (hence the value 0). When a + value is input the camera zooms out when turning
the mouse wheel to the front. When a – value is input the effect is reversed. The value
module defines the degree of camera shift per one click of the mouse wheel. Adjusting this
parameter to your needs you can define the starting value as 100. The mouse wheel is
inactive by default (0).
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3.1.2 Guidelines for the Design Tool user
1. Building model import
Steps:

Pictures:

1.1 Create a new project: select from menu
“File -> New Project”.

1.2 Import the building model in an STL file
format: select from menu “File -> Import
Building Model”.

Comments:
Import can be long process, but it is performed once for
Figure 8: Recommended orientation of
one model. During import, a mesh that allows the
building model
placement of panels is created on the basis of the building
model. To allow an appropriate import of the building model,
the model has to be saved in a text or binary STL file in which
the coordinates of triangle corners are in millimetres. It is
recommended that the base of the building is on the XY plain,
one of its corners is placed at the beginning of the coordinate
system, Z axis is pointing up and the front or rear façade is
heading towards the Y axis (as shown in Error! Reference
source not found.)
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2. Creating panels
Steps:

Pictures:

2.1 Create panels surface: panels’
p
creation is done by placing control
points on the surface of the building (or
other panels) that define the placement
of the panel corners and surface on
which it is to be placed. To insert a
control point click on the building holding
“Ctrl+Shift”. To create
eate a panel at least
three control points are required. First
three control points always define the
surface on which the panel is to be
placed. The user is able to create
rectangular (2.1.a)) or polygonal (2.1.b)
(
panels by choosing the related button.
2.1.a In the case of rectangular
panels, first two control points
define the line on which one of the
edges is placed, the third point
defines the length of the second
edged (as a distance from the first
line) and the placement of the
corners. Rectangular panels
panel are
created automatically after
inserting the third control point.
2.1.b In the case of polygonal type of
panels the control points in any
number define the placement of
the panel corners.

2.2 Characterize panels Double click on
panel name: to rename it, the user shall
change thickness, colour and
description for the newly created panel.
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2.3 Select and duplicate existing panels:
panels
select form the menu “Duplicate
Duplicate panels”.
panels
The first control point defines the place
where the first control point form
fo the
duplicated panel will be placed. The
second point will define the line on
which the second point will be placed.
The third point along with the first two
defines the surface on which the
duplicate will be placed. The panels are
created automatically after inserting the
third point.
Comments:
•

The option “Create
Create towards camera” controls the heading of the created panel. Since in
most cases user observes building from the outside, panel is usually created heading
towards the camera. However, in some special applications other heading may be
required. It is possible to create zero-thickness
zero thickness panels. It is useful for creating temporary
“positioning panels” or to increase the ergonomics during the creation of ad joint panels or
to have easier access to grid nodes – after creating a panel set you can assign their
designated thickness (Figure
Figure 9).

Figure 9:: Disabling “Create toward camera option allowed to create red panel without rotating a model

•

Using the panels duplication method the user can create panels which are exact copies of
the original or its symmetrical reflections. Figure 10 presents
nts the pattern panel (blue), the
order of its control points and its four duplicates (green) along with marking of the
placement of their control points. The user shall keep in mind that the first point of each
duplicate has a defined placement, but the second
second control point can be placed in any point
along the appropriate half line, and the third point can be placed in any place on the
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appropriate half plain.

Figure 10: Original panel and its duplicates

Creation of duplicates requires from the user a certain skill and consistency, because there
is no way to display the numbers of control points of existing panels. The user has to know
(check), which point of the pattern panel is to be considered.
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3. Organizing and editing panels
Steps:

Pictures:

3.1 Create hierarchic tree structure
to organize panels: to
o add a new
tree, click with the right mouse
button on the control on the left
side of the menu called “New
Category”).

3.2 Select panels: “shift” to select the
panel scope and/or “Ctrl”” to select
panels that are not placed next to
one another and drag them into a
newly created category.

3.3 Create subcategories using the
same method dragging one
category into another one:
double
ouble click on a category allows
to rename it.

3.4 Edit existing panels: select them
and then using the tree context
menu select “Edit
Edit Selected
Panels”. In case of editing several
panels the user can use automatic
numbering of panel names. In
order to do that, use the shape
counter in the panel name
<number>+ or <number>-.
<number> For the
next panels the counter will be
substituted with numbers starting
from the one given and increasing
or decreasing by 1,, depending on
whether you used + or -.
D6.5: Guidelines and protocols for the flexible molding and for the installation of anchoring systems and joints
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Comments:
The order of panel selection makes a difference. i.e.: if the user shift and select panels from top to
bottom, they will be numbered the same way. If the user select them from bottom to the top the
numbering will be reversed (5,4,3,2,1). The user can delete panels or categories selecting from the
context tree menu the option “Delete -> Selected Item”. Deletion of category does not delete the
panels or subcategories within it. All elements within a deleted category are moved to the top
branch of the tree.
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4. Export
Steps:

Pictures:

The Design Tool provides the possibility
to export panels sizes (4.a), building
model (4.b) and building grid for
anchoring systems tracking (4.c).
4.a To export panels select from “Tools
-> Export Panels”. The panel export
window will appear and the user
can select a designated catalogue
along with export options.
4.b To export the building model
contained in the project into a STL
file: select “Tools -> Export Building
Model” and input the desired path
for the STL file.
4.c To export the building grid to a text
file: select from menu “Tools ->
Export Building Grid” and input the
desired path for the text file. The
first row of the outcome file
contains the number of grid nodes,
the second – the number of grid
edges, next is the list of the grid
nodes coordinates in the form of
X;Y;Z and then a list of edges (start
– end) of the grid in the form of
X;Y;Z X;Y;Z.

Comments:
Panels can be exported to a form of STL models, PNG files containing information about the panel
along with its contour (similar to the one in The Navigation Window) and/or TXT files containing
information about the panels in text format. Selecting the option “Include building overview” adds a
miniatures panel to the image, showing the building along with highlighting of the panels position
on the wall. Generating of miniatures can take some time and can use up a significant amount of
RAM.
Additionally it is possible to create a HTML file allowing for an easy access to exported files. To do
that, the user shall select the option “Create HTML index file”. The user can adjust the way that the
HTML file looks to your needs, editing “files index_template.html” and “panel_template.html” placed
in the main application catalogue. Figure 11 shows a part of an example HTML file and a panel
exported to a PNG file. The graph contains the information about the panel, its concept drawing
describing the shape of the panel (the length of the sides in meters and the measure of the angle is
in degrees) along with the set of miniatures showing the placement of the panel on the wall. The
miniature on which the panel is closest to the camera is marked with a frame.
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Figure 11: The panel exported into a PNG image

Planning patterns distribution constraints
•
•
•
•
•

•
•
•
•

Panels shall be placed on the wall with 1 cm dilatation joint (in horizontal and vertical
directions) between each other.
Minimum dimension of the panel is 0,5 x 1,5 m.
Maximum dimension of the panel is 1,5 x 3,3 m.
Rectangular panels’ shapes are strongly advised. Non-rectangular panels can be
manufactured, but such process is more complicated.
In general, walls should be covered with panels having as wide as possible dimensions – it
allows to increase the speed of the insulation process and to decrease number of anchors
required. Although, depending on the transport costs / mechanical strength of building /
internal regulations, for different countries and on different buildings other strategies are
allowed.
Number of panels’ types to be manufactured for one building should be minimized.
If the texture for a panel is selected, it is important that its depth (largest distance between
the top and the bottom of textures profile) should be below 10 millimetres.
In general, panels should be placed evenly, with respect to the architectural features – lines
of the dilatations should in most cases remain straight, horizontal and vertical.
All criteria described above should be applied with a respect to the structural constraints,
which takes into account architectural and mechanical features of the building, like for
example steel construction, high performance concrete reinforcements etc.
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Table below provides the troubleshooting table in order to help the user in case problems occur
while using the Design Tool.
Table 1: Design Tool troubleshooting table

Problems
Building model does not look
good after import to the Design
Tool

It takes very long time to
import building model

Cursor does not snap to panel
edges/corners, and as result
panels connectivity is not as
desired

Possible causes
STL model created in the
cloud processing software is
somehow incorrect

Contingency
The user can try to use
external software (for instance
MeshLab), to display and fix
STL mesh.
If the user encounters
problems with edge detection
(EASEE Editor will not detect
edges between two walls),
Open Settings.ini file (in the
installation folder) with a text
editor shall be opened and
following parameters adjusted:
• Grid Plane;
• Grid Edge Threshold.
STL mesh on the model is very Up to some point, it is normal.
dense
After successful import, the
user shall always save your
project.
However,
when
exporting STL from the
external software, the user can
try modifying export settings
to avoid unnecessary density
increase.
Graphics picking tolerance is The
user
shall
open
not adjusted to your display Settings.ini
file
(in
the
resolution.
installation folder) with a text
editor, and adjust following
parameters:
• Grid
Edge
Snap
Distance
• Grid
Node
Snap
Distance
• Grid Edge Radius
• Grid Node Radius
After that, the user shall restart
EASEE Editor.
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3.2 Prefabricated insulating panels manufacturing
The scheme below is representing the main steps to be performed in order to manufacture the
prefabricated insulating panels for external envelope retrofitting developed and designed within the
EASEE project.

Manufacturing a new panel

1) EPS layer assembly

2) Formwork set-up

3) Mortar mix

4) Casting

5) Curing

5) Manufacturing

Figure 12: Guidelines blocks flow scheme for prefabricated panels manufacturing
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3.2.1 Glossary
Below is the description of the main systems (materials and components) needed for the
prefabricated panels manufacturing.
•
•
•
•

•
•
•

•

Spacers: Proper spacers have been designed in order to keep constant the layer thickness
during the sandwich panel casting at both sides of the EPS. Moreover, the spacers can
help the exceeding air to exit and avoid discrepancies in the panels finishing texture.
Fire connectors: An ad hoc serpentine folded steel wire is used in order to ensure a proper
fire resistance to the panel.
Formwork: dedicated technological equipment designed for the manufacturing of the multilayer panels for the building external envelope retrofitting with different sizes (see dedicated
datasheet at Paragraph 2.2).
Counter-moulds: Several sheet-like counter-moulds for a bas-relief pattern is used for those
panels reproducing an external facade different from a smooth one. The counter-moulds is
glued to one of the sides of the formwork (the one which reproduces the external facade).
The counter-moulds thickness and the texture reproduced could be different.
Bucket: dedicated buckets of different dimensions could be used for the mortar pouring into
the formwork. Thus, bucket is used as a hopper and can be opened to spread its content
on the formwork.
Eyebolt: two eyebolts are installed only in the top surface of the panels, because the
product is relatively light. Thanks to the spreader beam, the panel can be easily attached to
the crane and moved to the warehouse.
Overhead crane: an overhead crane, commonly called a bridge crane, is a type of crane
found in industrial environments. An overhead crane consists of parallel runways with a
travelling bridge spanning the gap. A hoist, the lifting component of a crane, travels along
the bridge. If the bridge is rigidly supported on two or more legs running on a fixed rail at
ground level, the crane is called a goliath crane.
Spreader beam: the spreader beam is used in order to extract the panels and handle them.
A spreader beam consists of a rigid beam connected to the overhead crane hook with
chains. Besides, the beam is equipped with a number of hooks that are connected to the
eyebolts, installed on the panel after casting.
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3.2.2 Guidelines
1. EPS layer assembly
Steps:

Pictures:

1.1 Lay the EPS on the proper position in
order to assemble it. The EPS is
supplied already of the needed size
and properly cut.Error! Reference
source not found.

1.2 Install the AR glass fabrics: the AR
glass fabric shall be installed with
horizontal and vertical warp on both
side of the EPS modules.

1.3 Anchoring boxes installation: the
anchoring systems have to be inserted
in their dedicated sockets.

Photo not available for confidentiality reasons

1.4 Insert spacer in the EPS in order to
keep constant the mortar thickness
during the panel casting at both sides
of the EPS. The proper number and
distance of the spacers shall be duly
taken into account.
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1.5 Fire connectors installation: EPS is
properly cut to insert the fire connector
represented by a serpentine folded
steel wire.

Comments:
Due to the challenging thickness of the two layer of mortars finding out the suitable spacers able to
fulfil their function as well as guaranteeing the panel’s aesthetic was a very difficult task. Moreover,
the smooth panels and the panels with particular finishing textures have different requirements with
respect to their production process. Thus, the choice of the most suitable spacer is of utmost
importance for the panels manufacturing.
Time required to perform this phase is approximately 90 minutes. 2 workers needed.
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2. Formwork set-up
Steps:

Pictures:

2.1 Set-up
up of the proper width and height
of the formwork: the setting shall be
done according to the panels thickness
and height/length through the proper
positioning of the formwork lateral and
inferior shutterings.

2.2 Clean the formwork in order to avoid
obstacles to mortar pouring and ensure
good aesthetic of the panels.

2.3 Apply/spray the demoulding agent on
its lateral surface in order to create a
form of physical barrier between
betw
the
formwork side and the mortar layer of
the panel and facilitate its proper
separation in the demoulding phase.

2.4 Position of the countermoulds/finishing layer to decorate the
external side (if required by the specific
panel design).
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2.5 Position of additional shuttering (i.e.
specific
shuttering
systems
for
balconies, windows, doors or any other
façade singularity that must be
replicated by the panel. These devices
will be assembled separately and
fastened to the formwork’s fixed front
side thanks to magnetic couplings.

Photo still not available since the production of
this kind of particular
ticular panels shall be still done

2.6 Set the EPS block assembled in step
1, properly shaped. The formwork is
designed so that a mistake-proof
mistake
(poka-yoke)
yoke) insertion of EPS places it
at the correct distance from the fixed
front side.

2.7

Set the different shuttering:
shuttering in
particular set the movable side
shuttering, the movable front side, the
top side shuttering.

2.8 Close and fasten the formwork,
formwork
through the following steps:
•
•
•

All tie-rods
rods must be put in
operation thanks to their large
pitch bolts.
All the locking screws on the base
of the movable front sides must be
tightened.
All the locking screws of the top
side shuttering must be tightened.
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Comments:
• Since the mortar pouring to produce façade panels is made at once, all steps related to
components positioning are made before closing the formwork. As a consequence, a key
role is played by the EPS insulating layer, on which all devices will be applied and fixed so
that they will be embedded in the mortar matrix. As soon as these operations are
performed, the formwork is ready for fastening and mortar pouring. Since, as stated above,
mortar must be poured in a limited range of time after mixing, the time schedule of mixing
and formwork setup must be properly calibrated.
• In order to provide a nice panels with respect to an aesthetical point of view) different
solutions for avoiding deficiencies/imperfections on the external side of the panels are
under investigations (see trouble-shooting table).
• Several movable side/top/bottom shuttering shall be also foreseen for the formwork
equipment in order to ensure the needed customizability for the panels production.
Time required to perform this phase is quite difficult to estimate since there are several variables to
take into account according to the typology of panels that have to be produced (size, finishing, etc).
Approximately 30 minutes are needed in order to prepare the formwork for standard production
(smooth panels) while the whole day could be necessary to prepare the formwork for a nonstandard panel (panel with different size and particular counter-mould for the texture). 2 workers
are needed.
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3. Mortar mix
Steps:

Pictures:

3.1 Set the materials needed and mix
them in the planetary
lanetary mixer to correctly
blend constituents.

3.2 Send the mortar mix
ix to formwork
through flying bucket.

Comments:
Thorough mixing is essential for the production of uniform, high quality concrete/mortar. For this
reason, equipment and methods should be capable of effectively mixing concrete materials
containing the largest specified aggregate to produce uniform mixtures of the lowest slump
practical for the work. In the EASEE case, this aspect
aspect is facilitated by the very small dimension of
aggregates, that makes the mixture fall in the mortar case, instead of the concrete one.
In order to correctly mix the mortar of the prefabricated insulating panels, any standard method
can be used, from very
ery basic ones (with drill mixers) to large industrial equipment. In the specific
case the EASEE project,, the production process of the prefabricated insulating panels is hold at
MAGNETTI’s premises, who owns equipment typical of large prefabrication plants.
plant
After mixing the mortar components, it is immediately transported close to the formwork, through a
flying bucket for concrete delivery. The mixer must be promptly washed with high pressure water
to clean the mortar from containers and mechanisms, before it hardens.
Time required to perform this phase is approximately 30
0 minutes. 2 workers needed.
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4. Casting
Steps:
4.1 Pour the mortar mix: as soon as the
mortar is delivered by the flying bucket for
concrete to the hopper above the formwork,
the mortar pouring can start. The flow rate
should follow a ramp from low values up to
about 12 l/min, when the level of mortar
poured has reached that of the valve and
there is no free flow of liquid within the
formwork.
4.2 Mortar pouring stopped when formwork is
filled and cleaning of equipment used
(hopper, etc)

Pictures:

Photo not available

Photo not available

Comments:
The selected pouring technique is still to be improved in order set-up a more automatic
manufacturing process and thus producing panels that are high-quality, double-sided, tightly
dimensioned elements.
Time required to perform this phase is approximately 30 minutes. 2 workers needed.
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5. Curing
Steps:
5.1 Curing of the panels (see comments)

Pictures:
Photo not available

Comments:
The prefabricated insulating retrofitting panel must cure for about 12-14 h, depending on the
environmental conditions of the plant (mainly temperature and humidity). In order to increase the
productivity, the formwork has been equipped with a dedicated finned piping system. Lowpressure steam curing adds moisture and increases the temperature, which are important factors
that accelerate the curing process: both result in an increased rate of hydration. Low-pressure
steam curing can be performed in an enclosed permanent structure or in a temporary enclosure
formed by a heavy sheeting. To achieve the best results when steam curing:
•
•
•
•

•

Apply elevated temperatures after the initial set of the fresh concrete. This is usually a
period of 2 to 4 hours.
Apply a gradual temperature rise of no more than 4°C per hour, up to a maximum
temperature between 50 and 60°C.
Maintain a relative humidity between 75-90%
Gradually lower the temperature at a rate not to exceed 6.5°C per hour, to avoid any
thermal shock. Moisture evaporates very quickly from a hot surface and the durability to
weathering and atmosphere will be detrimentally affected. Too rapid evaporation rate at
low humidity will cause the surface to dry out and produce a concrete structure that has a
permeable, poorly cured surface with relatively poor durability.
Continue moist curing after steaming, as needed.
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6. Handling
Steps:

Pictures:

6.1 Unfasten the formwork by
untightening the large pitch bolts of
tie-rods, the locking screws on the
base of the movable front sides and
on the top side shuttering.

6.2 Install the lifting eye bolts: the
eyebolts are installed in their holes in
the dedicated boxes. The overhead
crane is approached to the formwork
and the hooks on the spreader beam
are connected to the eyebolts. By
doing so, the panel will not fall down
when opening the front sides.

6.3 Remove the movable side
shutterings. In particular, the
movable front sides are displaced to
open the formwork. The special
shuttering systems for doors,
windows, etc. are removed as well.
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6.4 Extract the panel with overhead
crane. Once secured, the panel is
slowly extracted from the formwork,
first in vertical. With enough
clearance, the overhead crane simply
moves the element from its vertical
position in the form, to the storage
area.

6.4 Clean the formwork.

Comments:
After a trade-off analysis, the formwork was designed in order to cast the panel in vertical position
(lying on its bottom surface). The main reason that drove the decision was the fewer (virtually
none) tilting operations required, that strongly decrease the risk of damaging the panel during
handling and transport operations.
The prefabricated insulating retrofitting panel production process also eases material handling: the
anchors for the crane generates less stress on the freshly cast element. In fact often producers
add reinforcements just for the initial pick from a horizontal to vertical position.
Time required to perform this phase is approximately 30 minutes. 2 workers needed.
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Table below provides the trouble shooting table in order to help the user in case of problems occur
while using the Design Tool.
Table 2: Panels’ manufacturing process troubleshooting table

Problems
Problems of cracking found in
the panels of the maximum
size.

Possible causes
The main cause is the
phenomenon of shrinkage of
the mortar.

Not so good aesthetics of the Potential causes could be:
panels
• The sensibility of the
mortar to the outside
temperature
• The sensibility of the
mortar to the formwork
front side material
• The spacers used
• The
crackings
above
mentioned

Contingency
The shrinkage of the mortar is
essentially due to the intrinsic
characteristics of the material
and to the very thin thickness
of mortar.
The contingency plan is under
finalization. The use suitable
expansives
is
currently
implemented.
Potential contingency plans
are under finalization. The use
of polycarbonate sheet to be
used in place of the countermould (for a smooth exterior
finishing of the panel) and
glued to one of the sides of the
formwork (the one which
reproduces
the
external
facade) is under discussion in
order to ensure a perfectly
smooth texture. Also the use of
other kind of synthetic based
membranes to be embedded
within the formwork front side
is under investigation.
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3.3 Installation process
Installation process

Building relief and anchoring installation

Panels installation
Joints installation
Joints between
panels

Fenestration
joints

Corner
joints

Finishing works

Figure 13: Guidelines blocks flow scheme for panels installation
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3.3.1 Guidelines
1.
Building
relief
anchoring definition
Steps:

and
Pictures:

1.1 Survey of the existing
building by scanning
laser technique. The
advantages of this
technique are rapid
acquisition of the data,
the extreme precision,
non-invasive, nondependence on the
complexity of the work
detected and digitization
of all data acquired.

1.2 Definition and
verification of the
anchoring points within
the developed building
3D model through the
correct georeferencing
of the executive 2D
design. The correct
laser-survey of the
three-dimensional
surface enables to
identify and locate
discontinuities,
projections and out of
plumb of the facade and
facilitates the correct
positioning of the
anchoring location.
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1.3 Three-dimensional data
conversion into text
files in order to be
acquired by the total
station.

1.4 Definition of lead-off
with subsequent
determination of the
appropriate anchors
panel fixing, based on
the Design Tool output.

1.5 Tracking on the wall
properly prepared for
installation of the panels
by means of the total
station.
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1.6 Marking and realization
of the holes, always by
means of laser
technology, for the
anchoring points once
verified the vertical and
horizontal axes of the
identified points.

1.7 Laying, installing and
centering the bubble
(spirit level) of Halfen
anchorings.
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1.8 Verification of
horizontality by
centering the bubble
(spirit level) of the
overall perimeter
defined by the points of
the anchoring at the four
edges in order to ensure
a further verification of
the entire anchoring
system proper set-up.

1.9 Preparation,
verification and
control of possible
production
deficiencies of the
panels stocked on site
prior proceeding with
their installation.
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Comments:
• The required staff for the fixing of the anchors operate on special platforms loaders while
the panels are moved through a crane.

Figure 14: Equipment for panels installation

•

In the case of a rough existing wall it is important to smooth the external surface to have a
flat plane on which to install the anchoring system. Anchoring systems will be mechanical
(Figure 15, c)) in the case of reinforced concrete substructures or chemical substructures
(see Figure 15 a), b)) in the case of clay wall. The perfect verticality of the wall mounted is
assured by the tolerances inherent in anchoring systems.

a)

b)

c)

Figure 15: Type of anchoring systems according to the available facade

•

To keep as a reference the manual for anchoring installation provided by the anchoring
suppliers (HALFEN guidelines according to the type of anchoring provided) shall be
consulted.
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2. Panels installation
Steps:

Pictures:

2.1 Lift the first panel and place it
carefully close to the final
position. The installation and
leveling of the panel No. 1 on
the first row of anchors installed
is crucial for the correct
installation of the subsequent
panels.

2.2 Proper placement of the
anchoring within the boxes of
the panels. Move the panel up
to the anchors and match the
anchoring boxes of the panels
with the lower couple of the
anchoring systems. Than fix the
panel to the wall using the
upper boxes and anchor
system. It is important to check
that the anchoring are working
properly at shear and that are
positioned on the saucer and
not on the screw. In the case,
lengthen the screw and the
distance from the screwing /
unscrewing the pin).
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2.3 Check the gap between wall
and panel as designed
(distance from the wall to the
inside edge of the 4 panel
berths).

2.4 Adhesive polyurethane based
sealing tape lay on the
adjacent sides between panels.

2.5 Installation and leveling of the
panels after the first band.
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2.6 Check the sealing and level
(spirit level) of the second row
of anchors before installation of
the panels of the second row.

2.7 Installing the second row of
panels and positioning of a filler
to enhance the thermal and
energy capacity and avoid
thermal bridges. The proper
installation o f the first panel
determines the correct
positioning of subsequent
panels.

2.8 Concluding the installation of
the second row panels after
verification of the sealing and
the levelling of the superior
anchoring systems of the first
band.
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Comments:
• The panels have large areas but relatively low weights (0.54 kN/sm). This advantage is
reflected on the speed of assembly, since no scaffolding is needed for their installation but
only the use of wheeled cranes is foreseen. In the case of eaves projecting the use of
special sling bars counterbalanced flag will be foreseen for the assembly of panels,
especially those located in the top. In fact, in order not to interfere with potential eaves, and
then to avoid possible damage of the same, it is assumed to use such a sling for the
installation of all the panels. For simplicity, the assembly of the panels will gradually from
the lower row to the top ones.
• The staff required for the fixing of the panels will operate on special platforms loaders and
crane as already mentioned.
• The joint between the panels has been made using a low elastic modulus neutral-curing
silicone sealant with outstanding ageing resistance. The silicon has been placed on
polyurethane backfill material in order to reduce the danger of cracking. The elasticity
remains constant at temperatures ranging from -50°C to +100°C. The high resistance to UV
rays and atmospheric agents foresees that after 20 years of service under normal
conditions, the joints shows no trace of superficial cracks.
• In case of more rows of panels, perform again procedures from step 2.5 on.
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3. Joints between panels
Steps:

Pictures:

3.1 Laying the polyurethane
backfill material between
the panels for vertical and
horizontal joint.

3.2 Laying the low elastic
modulus neutral-curing
silicone sealant with
outstanding ageing
resistance.

3.3 Laying the polyurethane
sealant foam over the
whole perimeter.
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Comments:
• Under the geometrical aspect, the facade misalignments (out of plumb) shall be
compensated by the tolerances of the anchoring systems, or in case the misalignments
were very marked, using multiple ranges of anchoring systems.
• In the corners, the miter cutting of panels (cut at 45 °) allows the aesthetic homogeneity of
the façade, although it requires a much more complex processing of the panels. By
contrast, the 90 ° angle is much simpler but requires an additional processing on one of the
two panels accidents in order to mask the vertical section open.
• Regarding corner joints, WKP Plus sealing tape is suitable for sealing expansion joints in
building construction such as precast walls and wooden clinker. Thermal insulation and
waterproof seal between the prefabricated components, between window frame and the
wall, etc. The WKP tape is water noise and dust proof (ensure sealing against heavy rain),
it can be exposed directly to the weather when compressed between the two elements.
Absorbs vibration and follows the expansions. Protects against dirt and is not attacked by
birds. Suitable for concrete, stone, brick, brick, metal, wood, rigid PVC, Plexiglas, drywall,
glass, fiberglass and many other materials.
Tape color
Composition

Gray and black
Polyurethane foam with a fine, open cell structure, bitumen
free and after installation silicone free. The tape is provided
with a self-adhesive side based on an acrylic carrier.
Volume weight
110 kg/m3 (±10%)
Impregnation
Acrylate polymer dispersion
Temperature resistance
-30 +90 °C
Thermal conductivity
0.05 W/mK
Water vapour diffusion
µ≤100 as per DIN 18542
Fire behavior
Flame retardant – Class B1
Expansion times in the 0°C up to 10 days
joint
10°C 48 hours
20°C 3 hours
30 °C 10 minutes
Elasticity
Long-term elasticity is ensured for many years
Resistance
UV-resistant, weather-resistant, resistant to mold and
bacteria
Shelf life
2 years at +5 °C to +25°C
Application temperature
Day from +5°C
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4. Finishing works
Steps:

Pictures:

4.1 Flashing installation
over the whole
perimeter – lower side

4.2 Flashing installation
over the whole
perimeter –upper side

4.3 Flashing installation
over the whole perimeter
–left side
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4.4 Flashing installation
over the whole
perimeter –right side

4.5 Door frame finishing
with insulation,
Fiberglass net and plaster

Comments:
• Air knives that can then create on the back of the panels, in order not to create a worsening
of the energy balance, must be separated as by means of seals or fills so as to prevent
movements of air.
• After the installation of the panels, the workers shall proceed with the installation of the
elements in proximity of the openings (windows and / or doors) and at the top and bottom
elements of closure of the building if required. These elements shall ensure air tightness,
water tightness, vapour retarder, thermal insulation, acoustical insulation, elasticity,
aesthetics.
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Figure 16: Test facade installed
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Table below provides the troubleshooting table in order to help the user in case of problems occur
while using the Design Tool.
Issues
Surface roughness of the wall

Possible causes
Retrofitting process is usually
performed in order to enhance
the energetic behavior as well
as the aesthetic of old
buildings, whose external walls
are usually not very smooth
and not very nice.
Difficulties in the correct It is mainly due to the fact that
leveling of the first row of installers are working on an
anchors
existing building.

Fixes
To prepare a proper
surface
for
laying
anchoring systems

wall
the

For installers it is enough to
have as a reference the first
row and the outermost points
of each side of the facade in
order to verify if the panels are
compliant with the centering
the bubble (or to pull the wires)
Difficulties in the installation of Danger of crushing hands for Set-up of a sort of shelf to
the first raw of panels
workers
guarantee panels horizontal
level
while
safeguarding
workers hands.
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4 Conclusions
This report constitutes Deliverable 6.5 “Guidelines and protocols for the flexible molding and for the
installation of anchoring systems and joints” and presented the associated work that has been
done within Task 6.4 “Application Guidelines”. Indeed, the document provides specific guidelines
for the project developed applications (namely the Design Tool, the formwork for panels
manufacturing as well as the prefabricated panels installation process). Guidelines are based on
the activities performed towards the design and the installation of the prefabricated insulating
panels on the test facade. Guidelines have been provided in a practical and synthetic way and
have been supported by pictures of each steps to be taken, taking into account the target of endusers per each result. Technical datasheets have been set-up, and trouble shooting tables are
included, in order to support the end-users in solving the main problems that might occur. The
intent of the document is thus to constitute a stand-alone document, to be attached and sold
together with each project result, in order to increase their industrial exploitation value.

D6.5: Guidelines and protocols for the flexible molding and for the installation of anchoring systems and joints

57

